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1 Getting Started 
1.1 Introduction 
JUICE is a Microsoft® WINDOWS® application for editing, classifying and analysing large 
phytosociological tables. It includes many functions for easy manipulation of table and header 
data. The program is optimised for use with TURBOVEG software (Hennekens & Schaminée 
2001), which is currently the most widespread database program for storing phytosociological 
data in Europe; however, it is also possible to import data into JUICE from a spreadsheet data 
format file. In addition to basic functions useful for editing and publishing phytosociological 
tables, the program includes various analysis functions (such as Beals smoothing, Ellenberg 
indicator values, similarity indices, beta-diversity calculation, interspecific associations,  and 
analysis of diagnostic, dominant and constant species of synoptic tables) and classification 
functions using COCKTAIL (Bruelheide 1996, 2001), TWINSPAN (Hill 1979) or cluster 
analysis included in the PC-ORD package (McCune & Mefford 1999). JUICE can create 
artificial data for testing. Tables, synoptic tables, headers and different types of analysis 
(including fidelities, species groups, indicator values and diagnostic species) can be exported in 
four data formats: (1) MS-DOS text, (2) Rich text format for word processors (e.g., Microsoft® 
WORD®), (3) spreadsheet format (e.g., Microsoft® EXCEL®) or (4) database format 
(Microsoft® ACCESS®). The program directly supports cooperation with the D-MAP mapping 
package (Morton 2005), the R program (R Development Core Team 2010) and can create 
Cornell condensed files for other classification utilities such as CANOCO (ter Braak & 
Smilauer 2002). JUICE is continuously being developed (since 1998) by the Working Group for 
Vegetation Science at the Department of Botany, Masaryk University, Brno, Czech Republic. 
Free distribution of the program via internet has been available since 2001. This manual 
describes the possibilities of the program version 7.0.45 Newer versions may differ. 

1.2 Copyright Information 
JUICE is freeware which can be freely distributed as an original package. The program 
download on www.sci.muni.cz/botany/juice.htm is without registration. No official warranty 
or support is provided. Questions not covered by this manual or the FAQ can be sent to 
tichy@sci.muni.cz. In publications or reports containing outputs from the program, the paper 
with the basic information on the program (Tichý 2002) should be cited. 

1.3 Installation 
This chapter explains how to install and initialise JUICE.  

1.3.1 Content of the Installation Package 
Information about actual installation version, sample data, literature, courses and other JUICE 
news is available at the web page: 

http://www.sci.muni.cz/botany/juice 

The installation package can be downloaded directly from the internet address: 

http://www.sci.muni.cz/botany/juice/jc06_ins.htm  
There are two hyperlinks – a full installation download and a JUICE.EXE file download. New 
users must use the full installation for correct installation of all program components. The 
installation package contains path ‘Training data’ with a set of sample files and these files: 
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JUICE.EXE – the program file. This file can be replaced directly without new 
installation by a newer version of the EXE file. 
JCUPDATE.EXE – an automatic update procedute, which is activated from the JUICE 
program during actualisation. 
ELENB.TXT – Ellenberg indicator table (Ellenberg et al. 1992) formatted as simple 
text. The file covers six main environmental factors (light, temperature, continentality, 
humidity, pH/Ca and nitrogens/biomass productivity).  
KUBAT.TXT – species check list useful for phytosociologists from the Czech 
Republic. The check list has a correct nomenclature published in Kubát et al. (2002). 
NEWFLORA.TXT – older species check list acceptable in the Czech Republic, 
Slovakia, Austria and Hungary based on unpublished nomenclature. Users from other 
countries should export the check list from TURBOVEG. (See Section 1.4.2.) 
TWINSPAN.EXE – a modified version of the famous freely distributed classification 
program. This version is integrated with JUICE. It can also be run as a stand-alone DOS 
program. 

At the beginning of the installation, the user will have to specify if the program should check 
for older versions and reinstall them. This operation is strongly recommended, but in most cases 
it is possible to have several versions of JUICE installed on one computer.    

When installation is complete, you may run the program from the icon group ‘JUICE 7.0’. 

Note 1: The program is able to indicate an existence of latest version, which is newer than 
currently installed on your computer. An actualisation can be done directly using the button 
‘Download’ (Fig. 1), from the program menu Help, or the user can download a simple EXE file 
which must be copied directly into the existing JUICE directory (usually ‘C:\Program 
Files\JUICE 7.0’). If you install the program on a new computer, please use the full 
installation. 

 
Fig. 1: List of latest program versions and main improvements.  

Such information is visible when the mouse cursor is placed over the button ‘Download’.  

Note 2: In a network (computer labs etc.), we recommend installing JUICE on each computer 
individually. Otherwise, there might be conflicts between multiple copies trying to access the 
same directory on the host computer. The starting path with INI file and TWINSPAN must stay 
open for program outputs. 
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1.3.2 Computer Configuration 
The program is written for the WINDOWS operating system in English/US format. The pre-
defined decimal delimiter must be a period ‘.’. The program will automatically try to convert a 
decimal comma to a decimal point when the program starts. A previous selection of the decimal 
point is restored after the program termination. Some known problems occur with Asian 
formats of the operating system. Therefore, if you encounter problems such as absence of 
communication with TWINSPAN or unreadable export files, try setting ‘Regional Settings’ to 
English/US. 

The program has no special demands on computer hardware. However, listing through large 
tables may be slower on older computers.  

1.3.3 Program Settings and INI File 
JUICE saves the user’s settings and restores them the next time the program is used. The 
settings are saved in the JUICE.INI file, which can be found in the same directory as the 
program. This file is automatically generated the first time the program is run and it is updated 
during table operations. If the file is deleted from the JUICE directory, the program will use 
predefined settings. 

Note: Each line of the INI file contains a parameter name and a parameter value separated by 
a double colon ‘::’, thus it is possible to edit the file manually. However, almost all values can 
be managed directly from the program. Manually altering the INI file may cause problems. If 
you experience difficulty with the INI file, simply delete it. JUICE will generate a new one in the 
correct format.  
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1.4 Data Import 
The first step in working with JUICE is to open a table. JUICE does not support direct storage 
of phytosociological relevés. Therefore, all relevés must be entered using other software (such 
as TURBOVEG) and exported as a table that can be read by JUICE. JUICE accepts several 
different file formats:  

1.4.1 XML Format 
This format is useful for importing source data from the TURBOVEG database program 
(Hennekens & Schaminée 2001). The XML file contains full information about species names, 
synonyms, cover and header data, and it is not necessary to create any other file with additional 
information. The file structure is rather complicated, and manually entering data in this file 
format without TURBOVEG is not recommended. 

 
Fig. 2: XML file import. 

The XML file contains all header data, but JUICE allows reduced header data information. The 
user must select the fields to be imported from the left list box using the ‘Add’ button. All 
selected fields appearing in the right list box will be imported and mustn’t exceed 999 
characters. This format is advantageous only in case if the TURBOVEG species check list is 
published and needn’t be modified before publication. 

1.4.2 Cornell Condensed (CC!) Format 
The Cornell condensed format file consists of three parts: table data, species abbreviations and 
relevé numbers. Several types of CC! files exist – they differ especially in the table data format 
defined in the second line of the file. JUICE should accept any of these formats, as long as they 
conform to the following convention: the first number of the line gives the relative relevé 
number and the remainder of the line consists of pairs in which the first number refers to the 
species and the second number to the species’ cover. Cover values may be expressed as 
percentages or as categories on an ordinal scale (1-9). 

The species abbreviation section contains ten abbreviations per line. Each abbreviation consists 
of either 8 characters or 7 characters plus 1 character for the layer number. 
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The third section of the file is reserved for relevé identification numbers.  Each number has 8 
characters, and there are 10 numbers per line. A sample CC! file can be downloaded from the 
JUICE web page and tested directly in the program.  

 

Example: 

 
Header data are imported automatically if header data files have the same name as the CC! file 
and have a correct format. (See Section 1.4.8.) 

The import process starts with selection of the CC! file. Then the following window appears: 

 
Fig. 3: Cornell condensed file import (1st and 2nd step). 

Juice analysis                                                        T 
(I5,5(I5,F8.1))                                                      5 
    1    1     2.0    2     2.0    3    13.0    4     1.0    5    38.0 
    1    6     2.0    7     2.0    8     3.0    9     1.0   10     1.0 
    1   11     3.0   12     3.0   13     3.0   14     3.0   15     1.0 
    1   16     2.0   17     1.0   18     3.0   19    13.0   20     2.0 
    1   21     2.0   22     1.0   23     1.0   24     2.0   25     2.0 
    1   26     2.0   27     2.0   28     2.0   29     2.0   30    13.0 
    2    1     1.0    5     2.0   10     2.0   16     3.0   21     2.0 
    2   23     3.0   25     2.0   26    13.0   31     3.0   32     3.0 
    2   33     2.0   34     2.0   35    13.0   36     1.0   37    13.0 
    2   38     2.0   39     3.0   40     3.0   41    13.0   42     2.0 
    2   43     2.0   44     1.0 
    3    4     3.0    5     3.0    6     2.0   10     2.0   13     2.0 
    3   16     3.0   18     2.0   21     2.0   23     2.0   25     3.0 
    3   26     2.0   31     3.0   33     2.0   35    13.0   36     2.0 
    3   38     3.0   39     3.0   40     2.0   41    38.0   45     2.0 
    3   46     1.0   47     2.0   48     1.0   49     2.0   50     1.0 
    3   51     2.0   52    13.0   53     2.0   54     2.0 
    4    2     1.0    3     2.0    4     2.0    5    38.0    6     2.0 
    4   10     3.0   13     3.0   20     1.0   23    13.0   25     3.0 
    4   26     2.0   27     2.0   30    38.0   36     2.0   42     3.0 
    4   55     2.0   56     2.0   57     3.0   58     2.0   59     2.0 
    4   60     3.0   61     2.0   62     2.0   63     1.0   64     2.0 
    4   65     1.0   66     2.0 
0000 
ACHI#MI6AGRIEUP6ARRHELA6ASTEAME6BRAYPIN6BUPLFAL6CENTSCA6CLINVUL6CORUSAN7CRATMON7 
DACYGLO6ELYMREP6FESTRUI6FRAGVES6GENITIN6HIERPIL6HIERSAB6KNAUKIT6MEDIFAL6ORIGVUL6 
PIMP#SA6PLAALAN6PRUUFRU6RANUPOA6SALVPRA6SANGMIN6STACREC6TARASEO6VERBC-A6VICITEN6 
ALYSALY6AREN#SE6ASPRCYN6CHAARAT6FESTVAL6FRAGVIR6GERASAN6INULENS6KOELMAC6MEDIMIN6 
POTEINC6ROSA#CN7TEUCCHA6THLSPER6ARENSER6COLTARB7MEDI*VA6PRUUSPI7ROSAPIM6RUBUCAE6 
SCABOCH6SESEOSS6STAC#RE6THYU#PA6ACERCAM7ASTAGLY6CAREMIC6CARIBET4CRATMON4CYTINIG6 
ERYNCAM6EUPHPOL6GALUVEU6HELINUM6PICRHIE6ROSARUB4 
  400179  400180  400181  400182  
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The basic statistics of the selected file are presented under ‘File parameters’. If they are 
incorrect, this indicates that the file is not suitable for this type of import. TURBOVEG files are 
defined with species abbreviations in the format ‘7+1’ (7 characters encode the species name 
and the last character is reserved for the layer number); however, CC! files without layer 
identification can be imported by selecting the option ‘8 characters’. The scale is detected 
automatically, but it can also be selected manually. (TURBOVEG exports only percentage 
values.)  

The program checks all cover values and tries to convert them to 0.01, 0.1, 0.2, 0.3, 0.5, or 
whole numbers from 1 to 100. If a value cannot be imported automatically, it is necessary to 
supply the correct conversion. Double-clicking on a line in the ‘Covers’ list box opens a 
window for entering the corresponding value. 

 
Fig. 4: Cornell condensed file import (3rd and 4th step). 

The next step is to specify the species list. If the species list was loaded successfully and used 
for importing a previous table, the program will automatically use this pre-defined file as the 
source of full species names. However, it is possible to use a different species list or import 
species as abbreviations.  

Header data will be loaded automatically from a pair of header data files with the same name as 
the CC! file with suffixes EXP and STR. It is also possible to import a table without header data 
or use a different header data file by clicking on the button ‘Append new header files’. The 
program allows the use of headers from a different import package (e.g., headers with a 
differently defined list of fields). Such headers need not be complete. It is recommended that 
you test their compatibility with the ‘Test’ button. The test will identify the number of relevés 
with headers.  

Note: Connecting table data with headers is only possible if the header data file contains the 
‘Relevé number’ field with unique identification numbers. 

1.4.3 Species Lists 
Although the abbreviations used in Cornell condensed files should uniquely specify the species, 
the final presentation of the table usually requires full species names. The program uses a 
species list file in simple text format. Such a file can easily be exported from TURBOVEG. 
(From the ‘Manage’ menu in TURBOVEG, select ‘Species Lists’ and ‘Edit’. Enter the name of 
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the species list and select ‘Export’ and ‘Limited List For JUICE’.) It can also be created 
manually as a comma-delimited file or a file with a fixed length for each line. Examples are 
shown below: 

 
Note: The species list included in the JUICE installation package is useful only for central 
European users who are using TURBOVEG with the standard central European check list. 
Users from the Czech Republic can use the included KUBAT#.TXT check list with standard 
nomenclature (Kubát et al. 2002). A current version of this check list is available at:  

http://www.sci.muni.cz/botany/juice/jc06_che.htm  
A new species list file can be defined in the ‘Check List Import’ tab of the ‘Options’ window 
(available from the ‘File’ menu and the ‘Import’ menu). If no species list is defined, the 
program will open this window during the import of the CC! file: 

 
Fig. 5: Options (Check List Import). 

Format 1: 
----I------I-------------------------------------------------I 
1    ABIEALBAbies alba                                         
12251ABIEGRAAbies grandis                                      
2    ABIE-SPAbies species                                      
4    ABITASAAbietinella abietina var. abietina                 
5    ABITASHAbietinella abietina var. hystricosa               
3    ABITABIAbietinella abietina                               
Each column has the same number of characters in each line. The first line defines three fields with 5, 7 and 50 characters. 
 
Format 2: 
1,ABIEALB,Abies alba 
12251,ABIEGRA,Abies grandis 
2,ABIE-SP,Abies species 
4,ABITASA,Abietinella abietina var. abietina 
5,ABITASH,Abietinella abietina var. hystricosa 
3,ABITABI,Abietinella abietina 
Data are in three comma-delimited columns. 
 
Format 3: 
ABIEALB,Abies alba 
ABIEGRA,Abies grandis 
ABIE-SP,Abies species 
ABITASA,Abietinella abietina var. abietina 
ABITASH,Abietinella abietina var. hystricosa 
ABITABI,Abietinella abietina 
Data are in two comma-delimited columns. 
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The button ‘Open new check list file’ allows the user to specify a new species list file.  The ‘ID 
Number’, ‘Abbreviation’ and ‘Species Name’ boxes are used to define the number of characters 
reserved for each field.  If the first line of the file defines the length of these fields, the values 
appear in the boxes automatically. The file format can be tested by clicking on the ‘Test file 
structure’ button. ‘Check list encoding’ must be switched on for the NEWFLORA.TXT file. 
Other files are not encoded. 

1.4.4 Spreadsheet Format (Microsoft® Excel® Table) 
A spreadsheet format file contains the title of the table (first line), the number of relevés, the 
relevé numbers and the table itself (species name, layer and cover codes). Cover codes may be 
characters from the Braun-Blanquet scale (or any other) or percentage values.  

The Import Manager begins by prompting you to select a file.  When the file is selected, you are 
informed about the title of the table, the character used to delimit columns, layer information 
and table size (steps 2 through 5). If the file contains only species names without layer 
information, uncheck the box in step 4. In step 5, make sure that the indicated table size is 
correct.  In step 6, make sure the table corresponds with real data.  

 
Fig. 6: Import Manager for Spreatsheet File 

The last step is to specify the cover values. If the scale is in Braun-Blanquet codes or percentage 
values, simply select the appropriate option. Otherwise, cover values must be specified 
manually. All codes which have been found in the table will be displayed in the list on the right 
side of the window. Double-click on a code to enter a percentage value for the cover 
represented by the code. The program can continue only if all codes are associated with a whole 
percentage value.  

An example is given below. An example is also available on the JUICE web page. 
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The spreadsheet format must not contain header data. Header data can be imported separately as 
described in Section 1.4.8.   

1.4.5 Text Format 
For users without TURBOVEG, this is the easiest import format. The table consists of four files 
with the same name and different suffixes: TXT, TAB, EXP and STR. (Similar files can also be 
exported by JUICE. From the ‘File’ menu, select ‘Export’ and ‘Table’ and choose the ‘SIMPLE 
TEXT FILE’ format.). The user can change cover values by double click to the line on the list 
of found cover values during the import.  

The TXT file consists of three columns (species name, layer number and table data) separated 
by at least 5 spaces. 

The TAB file is optional. Each line contains a unique relevé identification number (in a range 
from 1 to 999 999). 

 
Table from  relevés of the file: paseky.wct 
Number of relevés: 5 
 
;; 434111 ; 434112 ; 434113 ; 311728 ; 311725  
Calamagrostis villosa;6;5;4;4;5;3 
Avenella flexuosa;6;2;2;3;1;2 
Vaccinium myrtillus;6;1;1;1;1;+ 
Rubus idaeus;4;2;2;2;1;. 
Maianthemum bifolium;6;2;3;3;.;. 
Veratrum album ssp. lobelianum;6;2;2;3;.;. 
Oxalis acetosella;6;2;2;3;.;. 
Senecio fuchsii;6;1;.;.;1;1 
Equisetum sylvaticum;6;2;2;.;.;. 
Phegopteris connectilis;6;2;2;.;.;. 
Anemone nemorosa;6;2;2;.;.;. 
Betula pendula;8;.;r;1;.;. 
Picea pungens;4;.;.;.;2;2 
Betula pendula;4;.;.;.;1;2 
Galium saxatile;6;.;.;.;+;2 
Trientalis europaea;6;.;.;.;+;+ 
Athyrium filix-femina;6;2;.;.;.;. 
Deschampsia cespitosa;6;1;.;.;.;. 
Luzula luzuloides;6;.;.;.;.;+ 
 
The second column represents layer; it is optional. All cover data can be converted into percentage numbers or some 
semi-quantitative scale. This format can use full species names or abbreviations. 

Anemone nemorosa                        6     22.... 
Athyrium filix-femina                   6     2....+ 
Atrichum undulatum                      9     .....+ 
Avenella flexuosa                       6     223123 
Betula pendula                          4     ...12+ 
Betula pendula                          8     .r1... 
Calamagrostis arundinacea               6     ....1. 
Calamagrostis villosa                   6     544533 
Carex leporina                          6     ....++ 
Deschampsia cespitosa                   6     1..... 
Dryopteris dilatata                     6     .....+ 
Epilobium angustifolium                 6     ...+.+ 
Equisetum sylvaticum                    6     22.... 
Fagus sylvatica                         1     ....+. 
Fagus sylvatica                         4     ...1.. 
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The EXP and STR files contain header data.  (See Section 1.4.8.)  

1.4.6 Comma Separated File (Databased Records) 
This format uses coding of each non-empty cell of the table on separate line.  

 

The first line of the imborted file can contain field names. In case, it is not true, select ‘Omit the 
first line’. Each line may contain any number of fields divided by comma or semi-colon. One of 
them must be an indicator of the plot (the number from 1 to 999,999), one of the species 
(character string of species name) and one of the species cover (percentage numbers 0.01, 0.1, 
0.2, 0.3, 0.5 or integers from 1 to 100). Species layer is an optional field. 

 

 
Fig. 7: Options (Check List Import). 

 

434111  
434112  
434113  
311728  
311725  
311724 

Relevé Number, Species Name, Layer Code, Percentage Cover 
1, Fraxinus excelsior, 1, 3 
1, Quercus petraea, 1, 63 
1, Quercus petraea, 4, 13 
1, Carpinus betulus, 1, 3 
1, Cyclamen europaeus, 6, 3 
2, Fagus sylvatica, 1, 88 
… 
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1.4.7 Clipboard as Spreadsheet File 
The spreadsheet can be imported to JUICE from the Clipboard. At first, the user must select the 
data (table) and copy them to the Clipboard. The data structure must be the same as for the 
‘Import from spreadsheet file’. Other steps are the same as at the Section 1.4.4. This function is 
useful in situation when the user has a table opened in Microsoft® Excel® and wants to put this 
table or its part to the JUICE program for easier modification or manipulation with rows and 
columns.  

1.4.8 Header Data 
There are several ways to import header data into JUICE: 

1. Header data are included automatically in the XML file exported from TURBOVEG. 
You can select which fields to import during the import of this file into JUICE as 
described in Section 1.4.1. 

2. When TURBOVEG exports a CC! file for JUICE, it automatically exports header data 
in an STR and an EXP file. The user must select header data fields to export during the 
export from TURBOVEG. Header data will import automatically with the CC! file if all 
the files have the same name. All header data exported from TURBOVEG in STR and 
EXP file can be also imported separately, i.e. independently from the table. Such 
function allows changing header information available for edited tables. From the ‘File’ 
menu, select ‘Import’ and ‘Header Data’. This is useful when (a) you wish to select 
different header data fields or (b) you need to add new header data to a spreadsheet 
format file or to any table without header data.  

3. Header data can be imported in comma or semi-colon delimited file.  
4. If header data is in Microsoft Excel table format, it is possible to import them via 

Clipboard. 
 

STR and EXP files are simple text files containing definitions and field values: 

An STR file defines table data variable names and their starting character position in each line 
of the corresponding EXP file. The first column defines the first character of the field; the 

second column represents the name of the field. 

An EXP file contains values of fields defined in a corresponding STR file (e.g., relevé 
information about the site and environmental factors). All fields must be consistent with the 
format specified in the STR file. 

 

  1  Table number 
  6  Relevé number 
 12  Year 
 16  Month 
 18  Day 
 20  Author code 
 24  Altitude (m) 
 28  Aspect (degrees) 
 31  Slope (degrees) 
 33  Cover total (%) 
 36  Cover tree layer (%) 
 39  Cover shrub layer (%) 
 42  Cover herb layer (%) 
 45  Cover moss layer (%) 
 48  Mosses identified (y/n) 
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Warning: Each STR file or field headers in comma separated file / clipboard must contain the 
field ‘Relevé number’(or ‘Releve number’) specifying where to find the relevé’s unique 
identification number. 

 

    1400753199606050001 260   5 100  0  0100 20Y 
    2400754199606050001 280   20 90  0  0 90  3Y 
    3400756199606050001 250   15 80  0  0 80  1Y 
    4400813199606190001 200   10100  0  0100  0Y 
    5402212199706280001 240   20  0  0  0 70 10Y 
    6403158        0139    27025  0  0  0 80  0Y 
    7403159        0139    27025  0  0  0 70  0Y 
    8403161        0139    15810  0  0  0 95  0Y 
    9403162        0139    15825  0  0  0 95  0Y 
   10403166        0139    2485   0  0  0 90  0Y 
   11403167        0139    22510  0  0  0 95  0Y 
   12403168        0139    22510  0  0  0 95  0Y 
   13403169        0139    22510  0  0  0 95  0Y 
   14403171        0139    22515  0  0  0 95  0Y 
   15403174        0139     9030  0  0  0 95  0Y 
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1.5 The Basics of Working with Tables 
This section describes the most basic functions for organising phytosociological data imported 
into JUICE. The entire process is graphically oriented and more or less intuitive, but the 
following text will explain some of the hidden features of the program.  

1.5.1 Table Window Components  

 
Fig. 8: Main window of the program. 

 
The table window is divided into three parts: short headers, species names and table data. The 
Species Data Column can hold additional information about a species such as layer, biological 
information or Ellenberg indicator value (Ellenberg et al. 1992). 

The Menu Bar is at the top of the window. The Icon Bar is below the Menu Bar. Some menu 
functions are directly accessible as icons. See the figure below. 
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Fig. 9 The Icon Bar 

 
Note 1: The buttons ‘Reset relevé colour’ and ‘Reset species colour’ have two functions: One 
click of the left mouse button will reset the currently selected colour, while double-clicking will 
reset all colours. (See Sections 1.5.2 and 1.5.3 for more information on colours.)  

Note 2: The Option Button opens the ‘Options’ window (also available from the ‘File’ menu). 
Its purpose is to provide quick access to the ‘Fidelity’ tab (see Section Chyba! Nenalezen zdroj 
odkazů.) but other option tabs are available (such as the ‘Display parameters’ tab described in 
Section 1.5.8 below). 

The Status Bar at the bottom of the window contains information about the last species selected: 
its order in the list, its full species name (to a maximum of 50 characters), its layer number and 
its total frequency in the data set. The values ‘Relative No.’ (the relevé’s relative number in the 
imported data set) and ‘Relevé No.’ (a unique TURBOVEG number in the range 1-999 999) 
refer to the most recently selected relevé. The ‘Row’ and ‘Column’ values give the current 
position of the cursor in the table. 

 
Fig. 10 The Status Bar 
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1.5.2 Mouse/Keyboard Functions 
Working with table data requires the use of the mouse in combination with the keyboard.  

1.5.2.1 Functions sorted by displayed objects 

 

In tables: 

 
Fig. 11: Table 

The three parts of the table (see Section 1.5.1 above) are sensitive to different operations: 

When the cursor is in the short headers: 
Left Button Click Highlight and select relevé. 

Left Button Double Click Display list of species in selected relevé and save selected relevé in 
text form to clipboard. 

Left Button Click and Drag Move currently selected relevé 

Shift + Left Button Click Make/remove separator line to the right of currently selected relevé.

Right Button Click Repaint currently selected relevé with current relevé colour. 

Shift + Right Button Click 
Repaint block of relevés with current relevé colour. (Click on the 
leftmost relevé to be selected. Hold Shift and click on the rightmost 
relevé. The entire relevé interval will be repainted.) 

When the cursor is in the species names: 

Left Button Click Highlight and select species. 

Left Button Double Click Open dialog window for editing species name, layer and data. 

Left Button Click and Drag Move currently selected species. 

Shift + Left Button Click Make/remove separator line below currently selected species. 

Right Button Click Repaint currently selected species with current species colour. 

Ctrl + Right Button Click Repaint currently selected species with current secondary species 
colour. 
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Shift + Right Button Click Repaint block of species with current species colour. (Click on the 
first species to be selected. Hold Shift and click on the last species. 
The entire species interval will be repainted.) 

When the cursor is in the table data: 

Left Button Click Highlight and select species and relevé. 

Left Button Double Click Display list of species in selected relevé and save selected relevé in 
text form to clipboard. 

Right Button Click Repaint currently selected species with current species colour. 

Ctrl + Right Button Click Repaint currently selected species with current secondary species 
colour. 

Shift + Right Button Click Repaint block of species with current species colour. (Click on the 
first species to be selected. Hold Shift and click on the last species. 
The entire species interval will be repainted.) 

In synoptic tables: 

 
Fig. 12: Synoptic table. 

Functions are slightly different in synoptic tables: 

When the cursor is in the short headers: 

Left Button Click and Drag Move currently selected relevé group (column). 

When the cursor is in the species names: 

Left Button Click Highlight and select species. 

Left Button Double Click Open dialog window for editing species name, layer and data. 

Left Button Click and Drag Move currently selected species. 

Shift + Left Button Click Make/remove separator line below currently selected species. 

Right Button Click Repaint currently selected species with current species colour. 

Ctrl + Right Button Click Repaint currently selected species with current secondary species 
colour. 

Shift + Right Button Click Repaint block of species with current species colour. (Click on the 
first species to be selected. Hold Shift and click on the last species. 
The entire species interval will be repainted.) 
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In header data: 

 
Fig. 13: Header data. 

 

These functions are defined for Header Data Display: 

When the cursor is in the header data: 

Left Button Double Click Display list of species in selected relevé and save selected relevé in text 
form to clipboard. 

Shift + Left Button Click Make/remove separator line below currently selected relevé. 

Right Button Click Repaint currently selected relevé with current relevé colour. 
Shift + Right Button Click Repaint block of relevés with current relevé colour. (Click on the top 

relevé to be selected. Hold Shift and click on the bottom relevé. The 
entire relevé interval will be repainted.) 

1.5.2.2 Mouse Functions Sorted by Similar Functionality 

Relevé/species selection: 

Left Button Click Table Select current relevé and species. 
Left Button Click Synoptic Table Select current species. 
Left Button Click Header Table Select current relevé. 

 

Separators: 

Shift + Left Button Click Table: Species or 
Short Headers  Add/remove species or relevé separator of selected hierarchy. 

Shift + Left Button Click Synoptic Table: 
Species Add/remove species separator of selected hierarchy. 

Shift + Left Button Click Header Table Add/remove relevé separator of selected hierarchy. 
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Colours: 

Right Button Click Table and Synoptic 
Table: Species 

Repaint indicated species with current species colour. 

Right Button Click Table and Header 
Table: Relevé 

Repaint indicated relevé with current relevé colour. 

Ctrl + Right Button Click Table and Synoptic 
Table 

Repaint indicated species with current secondary species
colour. 

Shift + Right Button Click Table and Synoptic 
Table 

Repaint block of species with current species colour. (Click
on the first species to be selected. Hold Shift and click on the
last species. The entire species interval will be repainted.) 

Shift + Right Button Click Table and Header 
Table 

Repaint block of relevés with current relevé colour. (Click on
the first relevé to be selected. Hold Shift and click on the last
relevé. The entire relevé interval will be repainted.) 

 

Manually moving species/relevé/relevé group: 

Left Button Click and Drag Table: Species or 
Short Headers  Move currently selected species or relevé.  

Left Button Click and Drag Synoptic Table: 
Short Headers Move currently selected relevé group. 

 

Editing species name or header data: 

Left Button Double Click Table and Synoptic 
Table: Species  Open dialog window for editing species name, layer and data.

Left Button Double Click Table and Header 
Table: Header Data Open window with function for editing header data.  
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1.5.3 Colours 
As indicated in the previous section, relevés and species can be assigned colours. These colour 
codes can then be used for data processing, analysis and classification. Relevés and species each 
have eight colours available, which can be selected from the Icon Bar. The basic colour for 
relevés is white, while for species it is black. Colours enable organisation or analysis of data in 
a selected part of the data set. Colour coding makes selection and manipulation of groups of 
relevés or species easier and quicker, and sorted data may have a clearer structure. The mouse 
commands for colouring relevés and species are described in Section 1.5.2 above. Colours can 
also be assigned according to information in the short headers, as described in Section 1.8.4. 
Using colour-coding to gather relevés and species into blocks is explained in Section 1.5.5 
below. Used colours are marked by black points in the bar with colours for fast selection. 

1.5.4 Separators 
Separators divide a table into sections. This is necessary for defining synoptic tables or species 
group tables. Such tables are used to analyse constancy, fidelity and similar measures of a 
relevé group’s relation to species or a species group’s relation to relevés. 

Separators are placed or removed by holding down the Shift key and clicking on the relevé or 
species with the left mouse button (see Section 1.5.2.) The other way is the menu ‘Separators’ 
for the automatically making or the removing separators in the table. There are four possibilities 
for making separators: make separators within short headers, within colours, within some 
special colour of relevés and the certain number of relevés (‘each X relevés’). All separators can 
be removed from or to same relevé. User can remove only separators of certain hierarchy (for 
example only separators on the level 2).  The separator appears on the right side of the indicated 
relevé or below the indicated species.  

 
Fig. 14: Separator switches in the Menu bar. 

The program includes the option to work with six hierarchical layers of separators.  Level 1 can 
be used for major groupings, level 2 can be used for subgroupings and so on. When the 
hierarchy is turned on, the user can choose how many levels will be displayed. The top level, 
level 1, is always on, while the bottom level, level 6, is only on if the user chooses to display all 
6 levels. These switches can be found on the Icon Bar or under the ‘Separators’ tab of the 
‘Options’ window (which can be opened from the ‘File’ menu or from the ‘Settings’ in the 
‘Separators’ menu). The hierarchy of separators can be removed by the function ‘Remove 
separators hierarchy’ in the ‘Separators’ menu. 

Some analysis demands the definition of groups as the dummy values. It enables the function 
‘Define Groups as a Dummy Variables in Header Data’ in the ‘Separators’ menu. The function 
assigns the number 1 to the first group. Other groups have been assigned the number 0. This is 
included to the header data file as the last column. At the second step the function included in 
the number 1 to the second group and other groups have the number 0 etc. 
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Note: Moving synoptic columns (see Section 1.5.2) will destroy relevé separator hierarchy. All 
separators in different levels will be changed into separators of the top level. 

1.5.5 Gathering Species or Relevés into Blocks 
Before separators can be used to define species or relevé groups, it is necessary to gather similar 
items to the same part of the table. While it is possible to manually drag each individual row or 
column to the appropriate place, it is quicker and easier to use colour-coding. This is a two-step 
process. The example below illustrates gathering relevés into a block. The process for species is 
analogous.  

Give the relevés to be gathered a single colour, distinct from the other relevés in the table. 

 
Fig. 15: The table with selected relevés. 

Gather the relevés using the arrow buttons on the Icon Bar or the ‘Move Relevés’ function in 
the ‘Sorting’ menu. Specify whether the relevés are to be gathered to the left or to the right. 
(The illustration below shows relevés that have been gathered to the left.)  

 
Fig. 16: The table after moving all selected relevés to the left.  
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Note that JUICE does not gather all the relevés to the leftmost edge of the table. They are 
simply gathered to the leftmost (or rightmost) relevé of the selected colour. To move the block 
of relevés to the left, use this trick: 

1. Drag the leftmost relevé in the block to the place the block should be. 
2. Gather the relevés to the left again. 

This will move all the relevés to the left.  To move them to the right, move the rightmost relevé 
to the desired position and re-gather to the right. 

If the program seems to not respond to an attempt to gather relevés or species, make sure the 
correct colour is selected in the Icon Bar. JUICE only gathers relevés or species of the selected 
colour. 

JUICE can also group species and relevés automatically without using colours. The ‘Sorting’ 
menu contains several other options for sorting species and relevés. See Section 1.6.3. 

 

1.5.6 Relevé Overview Display 
Each relevé in the table can be displayed in condensed form by double-clicking on it. (See 
Section 1.5.2.) Species in the relevé can be sorted by layer, cover, alphabetical order or current 
position in the table. When the relevé display is opened or its sorting method is changed, the 
relevé is copied into the clipboard memory – the user can paste this information into a text 
editor or other program. 

 
Fig. 17: Selected relevé displayed at the right site of the window. 

1.5.7 Editing Species and Header Data 
JUICE is not database-oriented software for data archiving. All changes are saved only in the 
current table without impacting a database source. Therefore, we strongly recommend archiving 
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phytosociological or ecological data in a database program (e.g., TURBOVEG) and making all 
changes in the original data set. 

However, it is possible to modify some data in an existing JUICE file:  

 
Fig. 18: The window for editing species names, layers and species data. 

a) Species names, layers, species data values and commentaries can be edited by 
double-clicking on the species name.  

b) Cover values displayed in the table can be edited from the ‘Table Simulation’ menu. 
Selecting ‘Add/Remove Species Cover’ opens a window for specifying the value to be 
written into the table.    

Warning: In cover-value editing mode, the program changes mouse functions. The left 
mouse button writes the specified cover value to the indicated position in the table, while 
the right mouse button deletes the value in the indicated position (i.e., overwrites it with 
cover value 0). It is best to save a backup file before editing cover data because JUICE 
does not keep track of the original values, so these cover modifications are irreversible. 
After data modification, select the ‘Table Simulation’ menu and ‘Add/Remove Species 
Cover’ once more, and mouse functions will return to normal.  

c) Header data can be accessed from the Relevé Overview Window. (See Section 
1.5.6.) Clicking on the ‘Edit header’ button opens the following window: 

 
Fig. 19: Editing header data. 

The two arrow buttons enable selection of the field to be edited. Click the right arrow 
button until the desired field name appears. Type the new value into the text box. Then 
press the ‘Save’ button. If the ‘Save’ button is not pressed, the value will not change. 
The left arrow button initially does nothing, but after the right arrow button has been 
pressed, the left arrow button can be used to go back to a previous field. 

1.5.8 Screen Options 
Display parameters are defined in the ‘Options’ window under the ‘Display parameters’ tab. It 
is possible to modify: 
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Fig. 21: Defined scales 

1. Displayed length of species names 
2. Width of species data field 
3. Size and style of text 
4. Background contrast. 

 
Fig. 20: Options window (Display Parameters) 

Note: The width of the Species and Species Data Columns can also be modified using the 
markers at the top of the table. Text size can also be modified using the two text size icons on 
the Icon Bar. 

   

1.5.9 Defining Scales  
All cover data are saved in the form of percentage 
numbers. The program accepts the numbers 0.01, 
0.1, 0.2, 0.3, 0.5 and all integer numbers from 1 to 
100. The program has four predefined scales: 
‘Braun-Blanquet Old’, ‘Braun-Blanquet Old and 
New’, ‘Ordinal’ and ‘Presence/Absence’. All 
other scales must be defined by the user. The 
scale is selected in a combo box in the ‘Display 
parameters’ tab of the ‘Options’ window. 
Selecting ‘User Defined Scale’ turns on the ‘Modify’ button. Clicking on this button opens the 
following window: 
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Fig. 22: Window for definition of user defined scale. 

Every percentage number must be represented by one character code which will be displayed in 
the table. This scale is saved in the JUICE.INI file and is loaded each time JUICE is started. 

1.5.10 Header Data 
Full header data are displayed separately. JUICE must be switched from Standard Display to 
Header Data Display by selecting ‘Extended Head’ from the ‘Head’ menu or by clicking on the 
Head Icon on the Icon Bar. In Header Data Display mode, each relevé has its own row. The 
header data fields are in the same order as in the EXP and STR files. (See Section 1.4.8 for 
more information on these files.) All names of fields defined in the STR file are written at the 
top of the table. All table data must contain the field ‘Relevé number’, which is a unique 
identification number connecting headers with table data. 

 
Fig. 23: Header data display. 
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All screen parameters are defined similarly as in the Standard Display (See Section 1.5.8.). 
Mouse functions are described in Section 1.5.2. If it is necessary to change this data, the 
changes should be made in the source data set. However, it is possible to edit this information 
within JUICE. See Section 1.5.7. 

Note: It is possible to add a new header field to the header data from short headers. To add 
new information (number or code with maximum length of 6 characters) from short headers, 
you must open ‘Head’ menu and select ‘Add Short Headers to Header Data’ (See Section 
1.8.6). Other possibility is to define the new field in TURBOVEG and re-export the header data. 
(See Section 1.4.8.)  

1.5.10.1  Selecting Relevés by Header Data 
Section 1.5.5 explains how to organise colour-coded relevés into blocks. JUICE includes 
functions for colour-coding relevés according to their header data: 

1. Select a relevé colour on the Icon Bar. 
2. Open the ‘Head’ menu and select ‘Relevé Colour According To The Head’. This 

will open the following window: 

 
Fig. 24: Window for colouring relevés by header data. 

3. From the list, select the relevant field. 
4. In the text box, type the text to be matched. 
5. Hit the ‘Continue’ button. 

Relevés matching the text are given the indicated colour. The number in the ‘Selected relevés’ 
field indicates how many relevés match the text. 

JUICE provides two text-matching functions. ‘Function LIKE’ requires exact matching of the 
text in the box, but it supports wildcard characters. A ‘#’ symbol represents any character and a 
‘*’ symbol represents any string of characters. For example, ‘1##’ can be used to select all 
relevés at an altitude of 100-199 m because it matches text like ‘132’ and ‘149’ but not ‘711’ 
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(the first character is not ‘1’) nor ‘1324’ (the text is more than 3 characters long). The text ‘1*’ 
would match all numbers beginning with ‘1’ including ‘1’, ‘13’, ‘149’ and ‘1324’. 

‘Function InStr’ looks for matches in any part of the selected field. It does not support wildcard 
characters. For example, to colour all relevés that mention ‘Germany’ in their locality, use 
‘Function InStr’ with ‘Germany’ in the text box. (Note that this is equivalent to using ‘Function 
LIKE’ with ‘*Germany*’ in the text box.) But to select only relevés with localities that begin 
with the word ‘Germany’, use ‘Function LIKE’ with ‘Germany*’ in the text box. 

1.5.11 Searching 
Finding a certain species or relevé can be difficult in larger tables. The ‘Find Species’ and ‘Find 
Relevé’ functions (available in the ‘Species’ or ‘Relevé’ menu or from the Icon Bar) will 
display a text box in the Status Bar below the table. Type in part of the species name and press 
the ‘Find Species/Head’ button. The program will find the next species name that begins with 
that text and highlight the selected row. Pressing the button again will find and highlight the 
next matching species.  

Example: The table sorted by layers contains the species ‘Alnus glutinosa’ in three layers (tree 
– 1, shrub – 4 and juvenile – 7). After the first selection of the ‘Find’ button, the program will 
display the part with the selected species in the tree layer, the second selection will move the 
table to the species in the shrub layer, the third selection will find ‘Alnus glutinosa’ in the 
juvenile layer, and the fourth selection will move the display back to the position with the 
selected species in the tree layer. 

When JUICE is in Header Data Display (see Section 1.5.10), the text box can be used to search 
for relevés that match the text. In this case, a match occurs if the text appears anywhere in the 
relevé’s header data. The list will scroll so that the next relevé that matches the indicated text is 
highlighted at the top of the list window. 

Note: It is also possible to match the text with any part of a species name. The mode of 
searching can be changed in the ‘Find Species/Relevés function’ section of the ‘General’ tab in 
the ‘Options’ window. 

 
Fig. 25: Options (General). 
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1.5.12 The ‘Undo’ Function 
Some operations (colours, relevé/species positions, separators etc.) are reversible. Often, an 
incorrect step can be repaired with the ‘Undo’ function (in the ‘Edit’ menu).  

Notes: ‘Undo’ is only supported for one operation. It is not possible to ‘Undo’ multiple 
mistakes. In addition, the ‘Undo’ function does not support changes in data structure (species 
names, cover codes, deleting relevés and species etc.). We recommend that you create backup 
WCT files as frequently as possible. 
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1.6 Editing Tables 
Analysis, classification or publication of phytosociological tables requires a clear data set 
without residuals or incorrectly identified species and with correct nomenclatorial background. 
If the source data set consists of relevés in different scales and taxonomical concepts sampled 
by different authors, it is necessary to unify the data. This section describes how to accomplish 
these operations.  

1.6.1 Merging Species 
Species should be merged immediately after importing the table. To merge nominally different 
taxa into one taxon, follow these steps: 

1. Sort the species list into alphabetical order. (From the ‘Sorting’ menu, select ‘Sort 
species alphabetically’ and ‘ALL’.) 

2. Choose a secondary species colour. Species of this colour will be merged. To select 
the colour, hold down the Ctrl key and click on the colour on the Icon Bar. The box 
labelled ‘<Ctrl>’ will display the selected colour. 

3. Mark species to be aggregated with this secondary colour. Hold down the Ctrl key 
while right clicking on the species name. Make sure no other species are marked 
with this colour. 

4. From the ‘Species’ menu, select ‘Merge <selected> Species’ or press Ctrl+L. 
5. Confirm name and layer of the new aggregated species. All the species contained in 

the resulting aggregated species are automatically deleted from the data set.  

The cover of the aggregation is calculated under the assumption that covers can overlap and that 
they do so independently of each other: 

Example: Species 1 – cover 50 %, Species 2 – cover 30 %, Species 3 – cover 20 %. JUICE 
starts with 50%, the cover of the first species. Under the independence assumption, the second 
species covers 30% of the area covered by Species 1 and 30% of the area not covered by 
Species 1. This gives an additional 15% cover (0.5 × 0.3 = 0.15). These two species occupy 
together 0.50 + 0.15 = 0.65 = 65 % of the sample plot. Species 3 covers 20% of this covered 
area and 20% of the remaining 35%. The area covered only by Species 3 is 7% (0.20 × 0.35 = 
0.07). The total area covered by at least one of the three species will be:    

0.50 + (1.00 - 0.50) × 0.30 + (1.00 - 0.65) × 0.20 = 0.72 = 72 %. 

Note that this is equivalent to calculating the area not covered by any species. Under the 
independence assumption this area is: 

(1 - 0.50) × (1 - 0.30) × (1 - 0.20) = 0.28 =28%. 

This means 72% is covered by at least one of the three species. 

This independence assumption is most appropriate when merging different layers for the same 
species. When merging distinct species of one layer into an aggregate, it may be more 
reasonable to assume the covers are mutually exclusive. In this case the average cover values 
computed by JUICE may underestimate the resulting cover; however, other aggregate statistics, 
such as presence/absence, remain valid. 

Note 1: The default name and layer of the aggregation correspond to the first species in the list. 
If you wish to use a different species to provide the default name and layer, simply move that 
species to the top of the list. This information can also be entered manually. 
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Note 2: Merged species are removed from the table. However, each merged species can be 
returned to the table with the function ‘Undelete Species’ from the ‘Species’ menu. See Section 
1.6.2. 

1.6.2 Deleting and Undeleting Species and Relevés 
To delete species from the table, give them a colour and select ‘Delete <colour> Species’ from 
the ‘Species’ menu. 

Species which have been deleted from the table or merged into an aggregation can be retrieved 
using the ‘Undelete Species’ function from the ‘Species’ menu. This opens a list of deleted 
species, which can be sorted by layer, name or time of deletion. Select the species to be restored 
and press the ‘Undelete’ button. Multiple species can be selected with Ctrl+click. A block of 
species can be selected by clicking on the first species and Shift+clicking on the last species.  

 
Fig. 26: Window for undeleting species. 

Relevés can also be deleted. From the ‘Relevé’ menu select ‘Delete <colour> Relevés’. 
However, there is no way to restore a deleted relevé. 

1.6.3 Sorting Species, Species Data and Relevés 
Several types of sorting are available from the ‘Sorting’ menu. In addition to basic species and 
relevé sorts, JUICE can also sort according to headers, average Ellenberg indicator values, 
clusters calculated in PC-ORD etc. 

1.6.3.1 Sorting Species and Relevés 
From the ‘Sorting’ menu, choose either ‘Sort Species’ (Ctrl+D) or ‘Sort Relevés’ (Ctrl+U). 
These functions sort species by relevés or relevés by species. The sorting hierarchy is according 
to (1) frequency, (2) order of relevés (species) and (3) cover. This means that a species which 
occurs in more relevés is ranked higher. If two species occur in the same number of relevés, the 
one that occurs in the relevé listed first in the table is ranked higher. Two species that have the 
same frequency and the same first relevé are ranked according to cover. An analogous system 
applies to relevés. 

Colours can be used to limit the list of species and relevés to be sorted.  
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Fig. 27: Windows for sorting species and relevés. 

Note: The relevé ‘Sorting’ window has a check box for altering the sorting method. When the 
box is checked, only frequency matters and the order of relevés with the same number of species 
records will not be changed. 

1.6.3.2 Other Species Sorting Functions 
‘Sort Species Alphabetically’ can sort all species into alphabetical order or it can be restricted 
to only sort the species of the selected colour. 

‘Sort Species By Species Data’ sorts according to the information stored in the Species Data 
Column. (See Section 1.7 for information on how to write data to this column.) This column can 
contain many types of information such as layer, Ellenberg indicator value, frequency or any 
other biological information about the species. The ‘Species Sorting Parameters’ window has 
several options. The sort can be restricted to species of the selected colour or expanded to 
include all species. Data can be sorted in alphabetical or numerical order and the order can be 
ascending or descending. 

 
Fig. 28: Window with species sorting parameters. 

Note: Numbers should be sorted in numerical order (1, 2, 3, 11, 12, 13, 21, 22, 23) while text 
strings must be sorted in alphabetical order. If the above numbers are sorted in alphabetical 
order, the result is: (1, 11, 12, 13, 2, 21, 22, 23, 3). 

‘Sort Species in Synoptic Table’ is available only in Synoptic Table Display mode. The 
‘Sorting’ window has several options. Species can be sorted by various criteria such as 
constancy, fidelity or average cover. Colour selection can be used to restrict the species 
included in the sort. This function is described in more detail in the second part of this manual. 
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‘Sort species by Decreasing Association with Other Species’ uses interspecific associations 
as the main sorting criterion. Interspecific associations between all possible pairs of species are 
calculated according to the selected fidelity index. For each species, the average value of the 
selected fidelity measure of the most similar species is calculated, and the data set is 
subsequently sorted by these average values. The number of similar species considered can be 
1, 3, 5, 10 or the calculation can include all the species that occur in any relevé with the species 
in question. 

 
Fig. 29: Sorting species by maximum fidelity values. 

Warning 1: Check the estimated time of calculation. After pressing the ‘Continue’ button it is 
not possible to cancel the process.  

Warning 2: The average fidelity value is written into the species data field. This enables the 
user to see the value, but it overwrites any existing species data. JUICE gives no warning 
before it does this.  

 

1.6.3.3 Other Relevé Sorting Functions 

‘Sort Short Headers’ is useful when important relevé data are stored in the short headers. 
Short headers can contain ecological information about the relevé, relevé number, number of 
selected species or other information. To write information to the short headers, select ‘Store 
Values to Short Headers’ from the ‘Head’ menu. (This information is described in detail in 
Section 1.8.2.) 

Note: Short headers are limited to 6 characters. Numbers should be sorted in numerical order 
(1, 2, 3, 11, 12, 13, 21, 22, 23) while text strings should be sorted in alphabetical order. If the 
example sequence above is sorted in alphabetical order, the result is: (1, 11, 12, 13, 2, 21, 22, 
23, 3). 

‘Sort Relevés by Header Data’ allows sorting according to any field in the header data. This 
function includes the option to write the initial characters of the selected header data field to the 
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short headers (so the user can see the values according to which the relevés have been sorted) 
and the option to add separators after each group of relevés with identical values. 

 
Fig. 30: Sorting relevés by selected header data. 

‘Sort Relevés by Classifications by Other Programs’ is used to display clusters computed by 
another program – either TWINSPAN, SYN TAX 2000, PC-ORD or MULVA. With PC-ORD, 
the cluster information must be saved in a comma-delimited file called ‘MATRIX2.CSV’. With 
MULVA, the table should be exported as a MULVA input file (from the ‘File’ menu, choose 
‘Export’ and ‘Mulva Input File’). Once analysed in MULVA, the resulting file, PRINDA 
(without suffix), can be loaded with the function ‘Sort Relevés By Clusters (MULVA)’. The 
sorting window using PC-ORD outputs is shown here: 
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Fig. 31: Sorting species by PC-ORD clusters. 

Double-clicking on the desired level of classification will sort the data set accordingly. The 
‘Tree’ button can be used to display a simple clustering hierarchy. The Y-axis is not scaled in 
this chart: 

 
Fig. 32: Dendrogram of PC-ORD cluster analysis. 
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‘OPTIMCLASS (Internal)’ button is related to the function OPTIMCLASS, which will be 
described in the second part of this manual. It tests all selected partitions (use mouse pointer and 
click to the list of clusters using Shift or CTRL button) to the number of diagnostic species. The 
function can find a peak of diagnostic species over the different numner of clusters. 

1.6.4 Autorepeat Function 
When a new table is imported into JUICE, it is often necessary to merge species to aid analysis. 
(See Section1.6.1.) The user may also wish to delete species that are not of interest to the 
current project. (See Section 1.6.2.) When new relevés are added to the original data set (e.g., in 
TURBOVEG) it will be necessary to perform the same mergings and deletions in the newly 
exported file. The ‘Autorepeat’ function, available from the ‘Species’ menu, can be used to 
avoid the tedium of repeating the same editing operations in multiple files. 

When the ‘Autorepeat Function’ window opens, press the ‘Add functions from WCT file’ 
button. This will allow you to select a previously edited file as a model for how the current file 
should be edited. 

 
Fig. 33: Autorepeat function. 

The ‘Autorepeat Function’ window will then contain two lists. On the left is a list of the steps 
that were performed to edit the selected file. On the right is a list of the species that were 
affected by the highlighted step. Species prefaced by ‘???’ were present in the model file but are 
not present in the current file. 

Pressing the ‘Run Selected’ button will cause all the editing steps from the model file to be 
performed on the current file. Alternatively, the user can choose, step-by-step, to either perform 
the highlighted step (‘Run Step’) or skip it (‘Skip Step’). 

Note: This function is mostly useful when the current table has exactly the same species as the 
previously edited table. When the current table has additional species, the results will often be 
unexpected. Suppose, for example, that the model file had Quercus robur in two layers that 
were subsequently merged, but the current file has Quercus robur in three layers. After 
performing the merge step from the model file, only two of the instances of Quercus robur will 
be merged. The third must be merged manually. The optimal application of this function is to 
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perform the same merging, deleting, or undeleting criteria in different sub-sets of one large 
data set or in the same data set after slight modifications of the source database.  

1.7 Species Data 
The second column with the light-grey background can hold additional species data (such as 
layers, ecological characteristics or biological information) which can be used in sorting and 
analysis. (Section 1.6.3.2 explains how to sort species by species data.) Species data can have 
up to 50 characters; however not all the characters are displayed. By default, the Species Data 
Column has a width of three characters. It can be enlarged in the ‘Display Parameters’ tab of the 
‘Options’ window, as described in Section 1.5.8.  

JUICE can write some information to the Species Data Column automatically. From the 
‘Species’ menu, select ‘Species Data’. The functions available are explained below. 

1.7.1 Layers  
A species’s layer is expressed as a number from 0 to 9. It is recommended that you use the same 
convention as the TURBOVEG database program: 

0 – not defined; 1 – tree layer (high) ; 2 – tree layer (middle) ; 3 – tree layer (low) ; 4 – 
shrub layer (high) ; 5 – shrub layer (low) ; 6 – herb layer (high) ; 7 – juveniles; 8 – 
seedlings; 9 – moss layer. 

Layer is the most important information about the species. It is displayed automatically at the 
bottom Status Bar near the selected species’s name. Layer can be displayed in the Species Data 
Column: from the ‘Species’ menu, select ‘Species Data’ and ‘Layer View’ or select the Layer 
Icon on the Icon Bar. (See Section 1.5.1.) Layer can be displayed as a number, as text or both.  

1.7.2 Frequency 
The ‘Species Data’ submenu (from the ‘Species’ menu) has functions for writing ‘Frequency’. 
‘Frequency’ is the frequency of species occurrences in the data set. The species freuency can be 
calculated for (1) whole table, (2) relevés of selected colour and (3) relevés where the species 
riches a cover higher than the set threshold value. These statistics can also be viewed by 
selecting ‘Species Statistics’ from the ‘Species’ menu. (To return to Standard Display, it is 
necessary to select ‘Species Statistics’ again.)  

1.7.3 Cover Values 
Several cover values can be displayed in the species data column. ‘Minimum Cover’ is the 
species’s minium cover in the data set. ‘Maximum Cover’ is the species’s maximum cover 
value in the data set. ‘Median Cover’ and ‘Avarage cover’ are calculated from all nonzero cover 
values. It is also possible to display Standart deviation of nonzero covers. 

1.7.4 Sequence and Species Colour 
The ‘Sequence’ function writes consecutive numbers into the Species Data Column. The ‘No. 
of Species Colour’ function writes each species's current colour to the Species Data Column 
according to the following code: 0 – black, 1 – red, 2 – blue, 3 – sea-green, 4 – green, 5 – 
yellow, 6 – violet, 7 – grey. 
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1.7.5 Transformation of Species Data (Menu Calculator) 
Numerical values (n) in the Species Data Column can be replaced by their squares (n2), square 
roots ( n ), multiplicative inverses (1/n), or their addition, multiplication or division by any 
constant value. 

1.7.6 Statistics Summarizing Relevé Data 
Short headers can contain data about the relevés such as means of Ellenberg indicator values, 
sums of species statistics, Shannon-Wiener indices, potential heat load etc. (See Section 1.8.) A 
statistic summarizing the short header data from the relevés in which the species occurs – such 
as minimum, maximum, mean median value and etc. – can be written to the Species Data 
Column. From the ‘Species’ menu select ‘Species Data’ and ‘Short Header Data’. This gives a 
menu of summarizing statistics to choose from.     

1.7.7 Indicator Values 
Indicator values can be written to the Species Data Column: from the ‘Species’ menu select 
‘Species Data’ and ‘Indicator Value’. This opens a menu for selecting whether to display 
indicator values for ‘Light’, ‘Moisture’, ‘Continentality’, ‘Temperature’, ‘pH’ or ‘Nutrients’. 
Before using this function, it is necessary that the indicator values be defined (See Section 1.9). 

1.7.8 External Species Data 
Other species data can be imported into JUICE if they are in a suitable format. An example of a 
simple text file (denoting ploidy level) accepted by JUICE is shown below:  

                                       

Each line has the same number of characters. Species name and other information occupy the 
same position.  

Note: The menu ‘File’ contains submenu ‘Conversion’ (See Section Chyba! Nenalezen zdroj 
odkazů..) where it is possible to convert coma or semi-colon delimited file to the file with fixed 
length of all fields. 

From the menu ‘Species’ select ‘Species Data’ and ‘External Species Data’. Enter the name of 
the file containing the external data. The following window will appear: 

... 
Abies alba                         20        60       40         
Abutilon theophrasti               0.2       1.8      1          
Acer campestre                     10        20       15         
Acer ginnala                       2         7        4.5        
Acer monspessulanum                1         9        4.5     
Acer negundo                       10        25       17.5       
Acer platanoides                   20        30       25         
Acer pseudoplatanus                20        40       30         
Acer saccharinum                   20        40       30         
Acer tataricum                     2         8        5          
Acinos arvensis                    0.1       0.4      0.25   
... 
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Fig. 34: Window for import of species data from external file. 

Species names in the external data file and the current table must have the same nomenclature. 
The ‘Parameters for species selection’ and ‘Species information’ bounds must be entered 
manually. The first number tells JUICE where to find the first character of the field and the 
second number tells JUICE where to find the last character. The scale displayed above the file 
excerpt can be used as a guide. For example, the column below the first ‘1’ corresponds to 
character number 10 and the column below the first ‘2’ corresponds to character number 20. 

Warning 1: Make sure that the range entered under ‘Parameters for species selection’ is large 
enough to include the longer species names. Ideally, the ‘Last character’ of the species name 
should be the character immediately preceding the first column of data. If JUICE seems not to 
be loading in data for species with longer names, this indicates the entered range may be too 
small. Of course, specifying too large a range will also cause problems.  

Warning 2: To ensure that the external data file will be readable, separate columns with spaces 
and not with tabs. (Your text editor should be able to display the file in a fixed-width font, such 
as Courier.)  Even though a TAB may appear the same as several spaces, JUICE will interpret 
it as a single character. This could result in nonsense in the Species Data Column or it could 
make it impossible to tell JUICE where species names begin and end, resulting in a blank 
Species Data Column. 

Note: The example window shown above illustrates that the external data file can contain 
several columns of data. You can choose which column to import simply by specifying the 
range. Note that if the column contains only one character, the ‘First character’ and ‘Last 
character’ values will be the same. 

If the option ‘Import data for [all] species’ is chosen, the program will import selected species 
information for all species of the table found in opened external file. This information will 
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appear in the ‘Species data’ field. If the same colour is chosen, the program will import species 
information only for the colour. 

The option ‘Mark all species with the value with the colour’ selects species by defined colour, if 
the value field is the same as in the external file. The ‘Species data’ field will not be filled. For 
example the option ‘Mark [all] species with the value [0.25] with the colour [red]’ can be used 
to colour species with the value [0.25] without actually importing the data. It is also possible to 
only re-colour species of a certain colour. 

1.7.9 Species Group Tables 
In addition to the functions for writing data to the Species Data Column described above, the 
‘Species Data’ submenu has four functions for displaying species group tables. Species group 
tables are similar to synoptic tables, but constancy is defined not for groups of relevés, but for 
groups of species. Each constancy row is identified by the name of the first species in the group. 
The species data is displayed if it is the same for all species in the group; otherwise, the field is 
filled with repetitions of the letter X.  

Each constancy row has 6 characters. Digits are displayed vertically.  

The species group table can display frequency (percentage values 0-100 %), categories (I-V), 
total cover (aggregate cover values from 0 to 100 % are calculated as described in Section 1.6.1) 
or absolute species numbers. To return to Standard Display, select ‘Species Group Table’ again. 

 
Fig. 35: Species group tables. 

1.7.10 Species Data Averages 
Groups of species defined by separators can have different species data values. If these data are 
numerical, it is possible to calculate averages, which can reveal differences between species 
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groups. The minimum, the maximum and the standard deviation can be displayed. To view 
averages of species data, open the ‘Species’ menu, select ‘Species Data’ and ‘Species Data 
Averages’. The list of results appears in the clipboard. 

1.7.11 Species Data Exports 
Species data displayed in the Species Data Column can be saved into a simple text file, which 
can then be imported into other tables as described in Section 1.7.8. From the ‘Species’ menu, 
select ‘Species Data’ and ‘Export Species Data’. For more information, see Section 1.10.9. 

Species Data can be also stored to the clipboard in the form of spreadsheet table. Such function 
allows fast and easy data transfer between JUICE and other programs. In that case, use menu 
‘Edit’ and ‘Copy Species Names, Layers and Species Data to the Clipboard’. 

1.8 Short Headers and Header Data 
Short headers can contain up to six characters displayed vertically above the table data. Not 
limited to identification numbers, this field can contain any brief information about a relevé that 
could be useful for relevé identification, classification or sorting. Various functions for 
specifying what is displayed in the short headers are found in the ‘Head’ menu. Relevés can be 
sorted according their short headers as explained in Section 1.6.3.3. 

1.8.1 Identification Numbers 
The ‘Head’ menu has functions for displaying any of four different relevé identification 
numbers: 

• The ‘Initial Entry number’ of a relevé tells what order it was in when the table was 
first imported. This number is displayed by default.  

Note: This number is not constant. When relevés are deleted from the table, the 
running numbers of the remaining relevés are updated, but the relative order of the 
running numbers remains unchanged. For example, if three relevés of lower running 
number are deleted, relevés 44 and 45 will be re-numbered 41 and 42  

• A relevé’s ‘Original Number (Relevé Number)’ is a constant, unique relevé 
identification number important for TURBOVEG users or other users who have their 
relevés identified by special numbers. 

• When ‘Group Number’ is selected, every relevé in the first group is given the 
number 1, every relevé in the second group is given number 2 and so on. (Groups are 
defined by separators placed by the user. See Section 1.5.4.)  

• When ‘Ordinal Number (in Curent Table)’ is selected, all relevés are re-numbered 
in the order they currently appear. If a relevé is moved, its sequence number will not 
be updated until this function is selected again. 

1.8.2 Other Short Header Values 
Short headers field can contain up to six characters of information about the relevé arranged 
vertically in the topmost table part. They can be used to distinguish relevé groups in the data set 
and define them with separators or colours (as described in Section 1.8.4). The functions 
described below are found in the ‘Head’ menu under ‘Store Values To Short Headers’. 
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1.8.2.1 Number of Species 
The function ‘Count <colour> Species’ counts all species of the selected colour (which could 
correspond to all mosses or trees, for example). Species with the same name originally recorded 
in several different layers are virtually merged and counted only once. 

1.8.2.2 Percentage Number 
The function ‘Percentage Number of <colour> Species’ calculates percentage of all species of 
the selected colour from each relevé. Species with the same name originally recorded in several 
different layers are virtually merged and counted only once. 

1.8.2.3 Percentage Cover 
The function ‘Percentage Cover of <colour> Species’ calculates total percentage cover of the 
selected species. This can be used to distinguish relevés in which the selected group of species 
is dominant from those relevés in which the group plays a marginal role. The total cover is 
calculated on the assumption that species covers can overlap and that they do so independently. 
See Section 1.6.1 for an example.      

1.8.2.4 Short Headers with Header Data 
The ‘Header Data’ function allows the user to write header data to the short headers. Any 
header data can be stored in the short headers; however, because the short headers can not 
display more than six characters, some header data fields (such as locality, geology or remarks) 
are not appropriate for conversion.  

 
Fig. 36: Moving first part of selected header field into sort headers. 

1.8.2.5 Diversity Indices 

The function ‘Shannon-Wiener Index’ writes the index value to short headers. The Shannon-
Wiener index is one of several measurements of biodiversity (Hill 1973). It takes into account 
the number of species and the evenness of the species. The index is increased either by having 
more unique species, or by having a greater evenness. 
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where S is the number of species and pi is the proportion of the individual species cover relative 
to the total cover. This value is also displayed in the Relevé Overview Window (see Section 
1.5.6) which can be opened by double-clicking on the short header. 

The function ‘Simpson Index’ is the second commonly used diversity index: 
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where S is the number of species and pi is the proportion of the individual species cover relative 
to the total cover. 

1.8.2.6 Evenness 
The program calculates two different measures of evenness:  

Shannon’s equitability (EH) proposed by Pielou (1975) is calculated by dividing H' by H'max. 
(Here H'max = lnS.) Equitability has a value between 0 and 1, with 1 representing complete 
evenness:  

.lnmax SHHHEH ′=′′=  (Eq. 3)

This value is also displayed in the Relevé Overview Window (see Section 1.5.6) which can be 
opened by double-clicking on the short header. 

The second measure of evenness available in JUICE is Evar which is equivalent to the arctan 
transformed Gaussian width (Smith & Wilson 1996): 

 

(Eq. 4)

1.8.2.7 Geographical Position Index 
The ‘Geographical Position Index’ calculates a virtual grid, assigns the same number to relevés 
in the same square and writes this number to the short headers. 

Such spatial stratification of table data is available if the header data contain information about 
geographical coordinates. There are two possibilities to archive coordinates: (1) fields 
LATITUDE and LONGITUDE (both 6, or both 7 characters), or (2) fields DEG_LAT and 
DEG_LON (13 characters), where latitude and longitude are archived in degrees. These fields 
must be included in the header data (files with suffix STR and EXP – see Section 1.4.8).  

Example 1:   LATITUDE:   491357       =  49°13'57" 
  LONGITUDE:  163420   =  16°34'20" 

Example 2:   LATITUDE:   0491357       =  49°13'57" 
  LONGITUDE:  0163420   =  16°34'20" 

Example 3:   DEG_LAT:   49.16357   
  DEG_LON:   16.47563 
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Selecting this function opens this window: 

 
Fig. 37: Window for calculation of grid cell relative numbers. 

The window is used to define the size of the grid spacing. The default values can be altered 
according to your project requirements. When you press ‘Continue’, the program will calculate 
an index for each grid cell and the indices will be written to the short headers.  

The ‘Within groups’ checkbox is useful when the data are divided by separators. When the box 
is checked, each relevé group is analysed as a stand-alone data set.  

The ‘Starting point’ shifts the grid corner from [0, 0] coordinates. 

Note: The grid indices do not indicate relative position. The square containing the first relevé is 
assigned the index 1. The square containing the first relevé that is not in square 1 is assigned 
the index 2 and so on. Thus relevés with consecutive indices are not necessarily in adjacent grid 
boxes on the virtual map 

1.8.2.8 Distance from Selected Relevé 
If the user wants to find the most similar relevés from the selected relevé, they can choose two 
measures of the distance. 

The first one is the Euclidian Distance from the selected relevé. The program shows calculated 
Euclidian distance and finds the most similar relevés from the data set. Data can be transformed. 
The second one is the Bray-Curtis (Sorensen) distance from the selected Relevé. Both measures 
can be saved into the short headers or onto the clipboard. 
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Fig. . 38: Window for calculation Euclidian and Bray-Curtis distance. 

 

1.8.2.9 Potential Annual Direct Irradiation (PADI) And Heat Load  
The function ‘Potential Annual Direct Irradiation And Heat Load’ can be used to calculate 
PADI or heat load for relevés based on slope, aspect and latitude as proposed by McCune and 
Keon (2002). 

There are three available models: 

Model 1: ln(Rad, MJ · cm–2 · yr–1) = –1.467 + 1.582 * cos(lat) * cos(slo) – 1.500 * 
cos(asp) * sin(slo) * sin(lat) - 0.262 * sin(lat) * sin(slo) + 0.607 * sin (asp) * sin(slo) 
 
Model 2: ln(Rad, MJ · cm–2 · yr–1) = –1.236 + 1.350 * cos(lat) * cos(slo) – 1.376 * 
cos(asp) * sin(slo) * sin(lat) - 0.331 * sin(lat) * sin(slo) + 0.375 * sin (asp) * sin(slo) 
 
Model 3: Rad (MJ · cm–2 · yr–1) = 0.339 + 0.808 * cos(lat) * cos(slo) - 0.196 * sin(lat) * 
sin(slo) - 0.482 * cos (asp) * sin(slo), 

where ‘asp’ is aspect, ‘slo’ is slope and ‘lat’ is latitude. 
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Fig. 39: Calculation of potential direct incident radiation and heat load. 

The window allows the user to select a model and test it on sample data. The user may then 
choose whether to write radiation or heat load to the short headers. For relevés which lack 
information about latitude, slope and aspect, a null value is written. 

Note: For more information, read the original paper of McCune and Keon (2002). Latitude 
should be included into header data (See the Section 0).     

1.8.2.10 Random functions 
There are several functions for the randomization of the data set. The function ‘Random 
number’ adds a random number of each relevé to the Short headers. The function ‘Random 
Permutation of the Short Headers’ casually mixes short header values, while the function 
‘Random Permutation of the Relevés’ mixes each relevé from the data set. 

1.8.2.11 Sum, Mean, Standart deviation, Minimum and Maximum  of Species Data 

There are several functions for summarizing numerical Species data into short headers. ‘Mean 
of <colour> Species Data’ calculates the mean over all species of the indicated colour in the 
relevé. Sum, Median, Maximum and Minimum functions are similar. 

1.8.2.12 Sum and Mean of Species Data Weighted by Cover 
There are two functions which calculate mean and sum of the Species Data for coloured species 
weighted by their cover in the plot. 

Note: These functions are only useful for analysing numerical species data. 
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1.8.2.13 Ellenberg Indicator Values  
Ellenberg indicator values can be written to the short headers by the button ‘Add Value to the 
head’ in the menu ‘Indicator Values’ and ‘Calculating for Relevés’. Before using this function, 
it is necessary that the indicator values are defined. See Section 1.9 for more information about 
Ellenberg Indicator Values. 

1.8.3 Import and Export of External Short Header Data 
External header data can be imported from a comma or semi-colon delimited text file. From the 
‘File’ menu, select ‘Import’ and ‘Short Headers’. The data file must have a column of relevé 
numbers (6 characters) paired with a column of short header values (6 characters). Short header 
files in this format can be exported from JUICE: from the ‘File’ menu, select ‘Export’ and 
‘Short Headers’. (See also Section 1.10.10).  

The ‘Import Short Headers’ window is shown below: 

 
Fig. 40: Window for import of short headers. 

The ‘Open’ button opens a browse window for finding the file with appropriate header data. 
The colour in the ‘For relevés’ field restricts which short headers will be updated. The ‘Source 
positions’ fields are used to specify the beginning and end of the header data in the source file, 
while the ‘Destination positions’ specify the position in the short header. In the example above, 
five digits, from the second to the sixth characters after the relevé identification number, will be 
stored from the first to the fifth position of the short head. 

An exporting file of short headers is a simple text with columns divided by semi-colons. The 
export is located in the menu ‘File’ and ‘Export’ and ‘Export Short Headers’.  

Note: If you respect the convention of reserving 6 characters for header data, you can combine 
several header data values for one relevé. For example, it is possible to use one file to import 
class number (2 digits) into the first two characters and another file to import year (4 digits) 
into the last four characters of the short header field. This will enable you to sort the table with 
classes as the main criterion and year as the secondary criterion. 

Note2: Similarly, the short headers import and export can be realised indirectly using the 
clipboard from the menu ‘Edit’. These functions make an exchange of data between JUICE and 
any other program faster and more flexible. 
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1.8.4 Colouring Relevés According to Short Header 
Relevés do not have to be coloured manually. It is possible to colour them according to the data 
in the short headers. From the ‘Head’ menu, select ‘Short Header Selection’. This opens the 
window shown below. Choose a colour, enter a value and specify whether to mark headers 
greater than, less than or equal to the entered value.  

 
Fig. 41: Short header selection window. 

Note: Alphabetical comparison should be used with text and numerical with numbers. The 
example below shows what happens when numbers are compared alphabetically:  

Numerical comparison: 12.345 > 9.8765 
Alphabetical comparison: "12.345" < "9.8765"  

With numerical comparison, text is interpreted as a number. If the text contains no digits, it has 
a value of zero. 

1.8.5 Short Header Averages, Minima and Maxima 
JUICE can measure the average, minimum, maximum or standard deviation value of the short 
headers within each group of relevés. (Groups are defined by separators. See Section 1.5.4) 
From the ‘Head’ menu, select ‘Short Header Averages’. The window shown below will appear. 
By default, the average value of the short header across each group is displayed. There are 
option buttons for displaying the average, the minimum, the maximum or the standard 
deviations. The list of values is also copied onto the clipboard and it can be pasted into a text 
editor with the command Ctrl+Insert or Ctrl+V.  
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Fig. 42: Averages, minima, maxima or standart deviations from short headers calculated for each constancy 

column of the table. 

1.8.6 Adding Short Headers to the Header Data 
It is possible to add short headers to header data by function ‘Add Short headers to Header 
Data’ in the ‘Head’ menu. The user must write the name of the new column in the header data. 
Short headers will be then included to the Header data file as the last column. 

1.8.7 Header data histogram 
This function compares relevés of selected colour with the rest of the table and identifies the 
relation of some qualitative relevé characteristic (e.g. vegetation type) to relevés of selected 
colour. Field ‘Statistic’ represents currently selected type of fidelity measure.  

 
Fig. 43: Header data histogram 

1.8.8 Relevé Colour According to the Head 
From the ‘Head’ menu, select ‘Relevé Colour according to the Head’. Choose the colour, select 
the header data field and specify the value. This function is similar to searching relevés in 
chapter 1.5.10.  
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1.8.9 Resampling 

1.8.9.1 Random and Systematic Resampling 

The user can randomly select relevés both with manual switches and automatically. The first 
horizontal bar selects separator group, where group of relevés will be selected. The second bar 
specifies the number of selected relevés.   

 
Fig. 44: Random and systematic resampling 

There are many possibilities for automatic selection of relevés.  The user can define a number of 
selected relevés in the whole table, or the maximal number of selected relevés in each relevé 
group. 

1.8.9.2 Geographical Resampling 

This type of resampling creates a virtual geographical grid of defined size (in minutes of 
latitude and longitude) and the defined number of selected relevés will be selected from each 
cell of the grid with preference of relevés with higher quality of recorded data.  
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Fig. 45: Geographical stratification 

1.8.9.3 Constrained Resampling 
 
Many subsets of the source vegetation database selected randomly from the data set are sorted 
by decreasing mean dissimilarity between pairs of relevés, and then sorted again by increasing 
variance of these dissimilarities. Ranks from both sortings are summed for each subset, and the 
subset with the lowest summed rank is considered as the most representative (see Lengyel et al. 
2010 for more details).  
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Fig. 46: Geographical (stratified) resampling and constrained resampling 

 

1.8.10 Imputation of Environmental Variable 
Large databases contain many relevés, but few of them contain measured environmental data. 
The process of indirect estimation of environmental factor is based on similarity in species 
composition between relevés. The similarity is calculated as the Sørensen similarity index 
applied to presence/absence, square-root transformed or untransformed vegetation data. The 
environmental factor for the target relevé is then imputed as the mean of observed values from 
several of the most similar calibration plots. An average factor value is calculated from selected 
number of calibration plots which fit the condition of minimum and maximum Sorensen 
similarity value. Values are calculated from white relevés for relevés of selected colour. See the 
paper Tichý et al. (2010) for detailed information. 

 

1.8.11 Linear Regression 
The function ‘Linear regression’ in the ‘Head’ menu is related to R-project script, which creates 
X-Y plot diagram and the description of linear regression with coefficient of determination. If 
you will choose this function, the window shown below will appear. Independent variable can 
be selected from the left, while the dependent variable from the right list.  

 

Note: Don’t forget to install R-project on your computer and initiate the connection with the 
JUICE in the ‘Options’ window. 

 
Fig. 47: Linear regression 
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The graph will appear after the selection of the button ‘Run R-project’. The graph can be copied 
into the clipboard (by CTRL+C), or saved in the ‘File’ menu of the ‘R Graphics’ window by 
function ‘Save as’ to several file formats.   

 
Fig. 48: Graph of the linear regression 

 

‘Shown statistic’ check box means that the next window will be opened together with plot 
diagram: 

 
Fig. 49:  List of the statistics of the linear regression 

The function calculated the minimum, median and maximum of residuals, intercept. residual 
standard error, multiple and adjusted R-squared and F-statistic with the p-value. The 
signification of the result is expressed by stars.  
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1.8.12 Short Header Sorting 
It is often desirable to sort relevés according to some criterion. First, the values under 
consideration should be written to the short headers as described in Section 1.8.2. Then, from 
the ‘Sorting’ menu, select ‘Sort Short Headers’. For more information on sorting, see Section 
1.6.3, especially Section 1.6.3.3. 

1.9 Indicator Values 

1.9.1 Initiation 
In the first step Ellenberg indicator values (EIV) must be initiated in the ‘Indicator Values’ 
menu by the function Initiation of indicator values’. ELLENB.txt file in the installation package 
contains an information about original Ellenberg indicators values for the ‘Light’, ‘Moisture’, 
‘Continentality’, ‘Temperature’, ‘pH’ or ‘Nutrients’. Using this file, Ellenberg indicator values 
will be automatically initiated and shown in the table in the right side of the form. If you don’t 
want to use the file from the package, you can create your own file with indicator values similar 
to ELLENB.txt file. Species both in that file and in the table must have the same name. The box 
on the left side displays species list and the upper text line highlights currently selected species. 
If EIV was not assigned, such species will be red coloured. 

All EIVs for species may be matched manually from the text file. The box with species and 
EIVs from the file will open on the right side of the window. If you choose some record and 
press the button ‘Replace’, the program will import EIVs from the species in the right box to the 
chosen species in the left box. The next possibility is the import EIV from the species data field 
and last allows to enter values directly.  

 
Fig. 50: Indicator Values - Initiation 
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1.9.2 Calculation of mean EIVs for selected relevés 
The function ‘Calculation for relevé’ you will find in the ‘Indicators Values’ menu. The user 
has to choose by mouse one relevé from the table before the analysis. Then the window for the 
calculation of mean EIVs will appear. It considers a list of species from selected relevé and their 
EIV values in the right side and a list of mean EIV values (together with the number of species, 
from which the value is calculated) in the left side of the window. Calculated values can be 
exported for relevés of selected colour or for all data set (including the information about relevé 
groups) to the text file useful in other programs. If you want use the value in other analyses 
within JUICE program, you can add the calculated value for one EIV to short headers by the 
button ‘Add value EIV to the heads’. The choice of exported factor can be done by simple 
mouse clicking of its name. Mean EIV value can calculated from values related to species, 
which may be weighted by some value saved in the Species data field. 

 

 
Fig. 51: Calculation EIV for relevés 

 

1.9.3 Correction of Indicator Values 
This function supports an estimation of EIVs for species, where such values were not defined. 
The program selects the most similar species to the target species, and from their EIV values, it 
will calculate a mean for species which fit a defined criteria. 
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Fig. 52: Correction of Indicator Values 

 

1.10 Exporting Data 
JUICE can produce several types of data – phytosociological tables, synoptic tables, graphs, 
ecological information about relevés or species, etc. To make this information available for use 
by other programs, JUICE supports many types of exports.  

1.10.1 Saving Files in JUICE 
Once the source table data are imported into JUICE, they can be saved in JUICE’s format, 
which may include extra parameters. From the ‘File’ menu, select ‘Save’ and enter a name for 
the file. Actually, three files are generated when a table is saved: a WCT, an STR and an EXP 
file. The WCT file has a special binary structure not suitable for manual editing, but the other 
two are simple text files containing header data in the same form as they were imported. See 
Section 1.4.8. 

Note: Although the ‘File’ menu does not explicitly have a ‘Save As’ option, ‘Save’ actually 
works the way ‘Save As’ does in many other programs. A dialog box will open and you will 
have the opportunity to either confirm that you want to save the file under its current name or to 
enter a new name. Thus it is possible to save an altered file under a different name without 
overwriting an older version of the file. Furthermore, before JUICE overwrites an existing file, 
it asks for confirmation. 

1.10.2 The Current Export File 
JUICE’s standard export is a rich text format (RTF) file to which subsequent exports are 
appended without overwriting previous exports. This is useful for exporting running results 
from interspecific associations or COCKTAIL analysis, for example. The file into which JUICE 
will export appears at the top of the ‘Export’ menu (available from the ‘File’ menu). Clicking 
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on this ‘Current File:’ function opens a window where the current export file name can be 
changed. If the name is not changed but the ‘Save’ button is pressed, JUICE interprets this as a 
command to wipe the export file clean and start over. (JUICE asks for confirmation before 
erasing the contents.) Another way to access this window is through the ‘Export’ tab of the 
‘Options’ window: clicking on the ‘Change File’ button will open the export file name window.  

1.10.3 Table Export 
From the ‘File’ menu, select ‘Export’ and ‘Table’. This will open the ‘Table Export’ menu, 
which offers several different export formats.  

The default, ‘to RTF File’, appends table to RTF file described in the previous section. All 
other formats prompt the user for a file name and export the data to this new file (overwriting 
any previous file of the same name). 

The function ‘to Spreadsheet Format File’ will generate a stand-alone TXT file separated by 
semi-colons and accepted by spreadsheet programs sSee Section 1.4.4.). This table is divided 
into two parts: table and header.  

The function ‘to Spreadsheet Format File (2nd version)’ will generate a stand-alone TXT file 
separated by semi-colons and accepted by spreadsheet programs. Nevertheless, the user can 
choose values for export of the table (percentage cover values, Braun-Blanquet cover codes and 
presence/absence data). Header data and cover values are in the same table, but this export has 
header information at the beginning. Furthermore, the former format presents header data by 
listing one relevé data per row, whereas this header format is transponed. 

The function ‘to Database Files’ produces four files: SPECIES.TXT, which contains species 
names, layers and Ellenberg indicator values (if they have been imported), TABLE.TXT with 
table data (species number, relevé number and percentage cover), HEADER.TXT with all 
header data. (These are only the default names; the user can change them.) These three files 
have the fixed lenght. The fourth file is the FULL TABLE.TXT, which is separated by colon 
and replicates the data from TABLE.TXT, but in different format. These files can be imported 
into a database program and connected through Id. number of relevés. 

The function ‘to Simple Text File’ saves the file as simple text (TXT) (see Section 1.4.5.).  
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Fig. 53: Table export 

It is possible to restrict export to relevés of a certain colour. The ‘Species Exported’ box gives 
the option of exporting all species in the table or only those species which appear in the selected 
relevés.  

Note: Exporting all species can be useful. To export a large table for printing, select a screen-
full of relevés at a time and export all species. When the resulting files are printed out, the 
species lists will be complete and the printouts can be physically spliced together.  

The standard RTF export file can contain separators. There is also the option (again, only for 
RTF export) to include only species which appear in at least 2, 3 or 4 relevés, listing the rarer 
species below the table in condensed form. The length of the species name can be limited, with 
a maximum length from 4 to 50 characters.  

JUICE remembers original percentage cover values as whole numbers (1-95), but they are 
replaced by single characters during export (except for the ‘Database Files’, where percentage 
numbers are exported). The list in the ‘Table Export’ window contains a list of percentages 
(‘Perc. value’) on the left paired with the character to be exported (‘Phyt. code’). To change an 
export character, double-click on the corresponding percentage value. Newly defined scales can 
be saved for future use by pressing the ‘Save’ button. Later, they can be loaded with the ‘Load’ 
button. 

1.10.4 Synoptic Table Export 
From the ‘File’ menu, select ‘Export’. If JUICE is in Synoptic Table Display mode (See the 
second part of this manual) the ‘Synoptic Table’ export function will be available. This provides 
four possibilities to:  

1. Export the synoptic table into the current RTF export file for presentation or 
publication.  

2. Export the synoptic table into CSV file separated by the semicolon for the using in 
spreadsheets programs. 
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3. Export the transposed synoptic table into CSV file separated by the semicolon. 
4. Export the synoptic table into a Cornell condensed (CC!) file for analysis by another 

program such as CANOCO (ter Braak & Smilauer 2002) or PC-ORD (McCune & 
Mefford 1999). This option is available only when a ‘Percentage Constancy’ 
synoptic table is displayed. 

Option 1 opens the following window, where the parameters of exporting the table may be 
modified: 

 
Fig. 54: Window managing synoptic table export. 

Synoptic tables may be saved in single or combined form (See the second part of this manual). 
All data will be saved similarly to the way they are displayed on the screen. 

1.10.5 Other Exports into the RTF Export File 
The current RTF export file is opened for running exports of interspecific associations created 
during COCKTAIL classification and Matching. More information about COCKTAIL 
classification is written in the second part of this manual. 

1.10.6 Special Export Formats 
The ‘Export’ submenu of the ‘File’ menu includes the option to export the table in a variety of 
other special formats, enabling the data processed by JUICE to be analysed more precisely. The 
program supports table export as a Cornell condensed file, R-project format TXT file a 
MULVA input file, SYN-TAX files or a MATLAB file. A text export of similarity indices of 
relevés to constancy columns is available from the menu ‘Analysis’ and ‘Matching’ (See the 
second part of this manual).  

1.10.7 Export for D-MAP File 
D-MAP (Morton 2005) is simple GIS software which is very useful for presentation of spatial 
data on a national or regional scale. In comparison with sophisticated GIS software, it gives 
faster and generally better results because small, clear maps with reduced details for publication 
are usually required for publication. JUICE supports easy communication with D-MAP.  

The header data must contain LATITUDE and LONGITUDE fields represented as six or seven 
characters corresponding to degrees, minutes and seconds (as explained in Section 0). 

The D-MAP software must be installed on the computer. The file group setup of D-MAP will 
help to create group ‘JUICE <title>’ with manually defined boundaries and parameters. 
Distribution data will be stored in the JUICE.DIS file. 

Parameters such as frame, grid spacing and symbol size must be stored in the PAR file in 
D-MAP. 
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From JUICE’s ‘Options’ window, select the ‘External Program Paths’ tab and define the 
D-MAP path. This will allow you to run D-MAP automatically after export selection. 

JUICE can export spatial data for three different parameters for: selected species (to see the 
distribution of selected species), a group of selected relevés (to see the spatial distribution of a 
vegetation type) or all species in the table. 

 
Fig. 55: Window managing synoptic table export. 

 

 
Fig. 56: Communication window and example of the distribution map created by D-MAP. 

1.10.8 Relevé or species distribution in Google Earth 
The program Google Earth is widely distributed freeware, which is useful for simple GIS 
mapping. JUICE supports mapping of relevé group, species or whole table distribution within 
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Google Earth in case if this software is installed (menu ‘File’ and ‘Export’ and ‘Mapping in 
GOOGLE EARTH’). All locations are highlighted by a special symbol with the relevé number 
and the label of relevé group.  

 

1.10.9 Species Data Export 
Species data (see Section 1.7) can be imported or created manually (see Section 1.5.7). Their 
simple format allows the saving them for the next future use. The information is related to 
species name, and then these data can be also imported into other similar tables, where the list 
of species occurring there is more or less the same. Export file has the following structure 
(species name, layer and species data value): 

 

1.10.10 Short Header Export 
Short header data can be exported into a simple text file (see Section 1.8.3). The file contains 
Relevé number, Sort header value, Group number and a 1 or 0 representing presence or absence 
of a separator on the right side of the relevé: 

 
 

1.10.11 Header Export 
Header data can be exported into a simple text file by the function ‘Export Headers for 
<colour> Relevés’ in the ‘Export’ menu. This funtion calls following window, where the user 
can choose header fields for export to the text file. Information about headers is in the section 
1.8.  

Fallopia convolvulus                              6     arc 
Lapsana communis                                  6     arc 
Silene latifolia subsp. alba                      6     arc 
Viburnum opulus                                   4     nat 
Sorbus aucuparia subsp. aucuparia                 4     nat 
Ranunculus sceleratus                             6     nat 
Populus x canadensis                              1     neo 
Epilobium ciliatum                                6     neo 
Pinus nigra                                       1     neo 

400001;    40; 1 ; 0 
400002;    46; 1 ; 0 
400003;    53; 1 ; 1 
400004;    58; 2 ; 0 
400005;    40; 2 ; 0 
400006;    48; 2 ; 1 
400050;    52; 3 ; 0 
400051;    38; 3 ; 0 
400052;    53; 3 ; 1 
400053;    52; 4 ; 0 
400054;    73; 4 ; 0 
400055;    56; 4 ; 0 
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Fig. 57: Window for the export of headers to the text file  

1.10.12 Export of the Interspecific Associations 
The function ‘Export Interspecific Association’ (‘Export’ menu) creates pairwise associations 
between each pair of species, sorts them and selects one, three, five etc. the highest average 
values for selected type of fidelity. The information appears in currently initiated RTF export 
file. For more information about interspecific associations see in the second part of this manual.  
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1.11 Conversion 
 

Different programs load the data in the different formats. The function ‘Conversion’ in the 
‘File’ menu changes the semi-colon separated file or the comma separated files to the text file 
of the fixed length. At the first step, the user must choose the file for the conversion. And the 
second step is the saving of the new text file with the fixed length. 

 


